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INTRODUCTION & OVERVIEW

CT DEEP’s Water Monitoring and Assessment Program offers support to volunteer groups interested in
monitoring stream temperature in their town or local watershed. Staff in Program have developed the
enclosed protocols and data submission guidance to support groups interested in submitting their stream
temperature data to CT DEEP. To insure data usability by DEEP, volunteer group coordinators are
strongly encouraged to contact CT DEEP prior to commencing stream temperature monitoring
programs.

STREAM TEMPERATURE MONITORING TIMELINE

CT DEEP’s WPLR Monitoring and Assessment Program encourages volunteer groups interested in
collecting stream temperature data collect year-round stream temperature data. To successfully
incorporate volunteer data into WPLR Monitoring and Assessment Program projects, volunteer data
must, at a minimum, be collected hourly from June 1 through August 31%.

Monitoring activities typically begin during the spring, according to the following schedule.
e March/April — Logger QC checks conducted; monitoring sites field checked for suitability
e May — Loggers deployed
e June-September — Loggers remain deployed; Field checks conducted when possible
e October — Loggers downloaded
e November-February - Loggers remain deployed; Field checks conducted when possible
e March/April — Loggers retrieved from field; loggers downloaded and QC Checked
e May — Loggers redeployed

PROGRAM TRAINING REQUIREMENTS

CT DEEP provides field-based training for groups interested in developing a new stream temperature
monitoring program. The V-STeM Coordinator will work with local group leaders to insure they are
familiar with CT DEEP’s monitoring and quality control protocols as well as the requirements for
submission of external stream temperature data to DEEP. It is the responsibility of the local group
leader to ensure that all volunteers participating in their local stream temperature monitoring program
are trained in the enclosed protocols prior to assisting with local monitoring efforts.

DATA STORAGE

All volunteer stream monitoring data is uploaded to the online Spatial Hydro-Ecological Decision
System (SHEDS) Stream Temperature Database (http://db.ecosheds.org/viewer). Through the Stream
Temperature Database, groups can:

e View an interactive map of all past and current monitoring stations in Connecticut
« Explore graphs of stream temperature collected by volunteers
o Download station information and the corresponding data
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DATA INTERPRETATION

Groups interested in interpreting their data are encouraged to refer to Appendix D for instructions how

to analyze stream temperature data according to Connecticut’s cold, cool, and warm water stream

classifications.
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RECOMMENDED EQUIPMENT LIST

Below is the list of specific equipment that CT DEEP’s Monitoring & Assessment Program will use during 2015
to measure stream temperature. We have had success using these equipment in the past and therefore feel
comfortable recommending them to volunteers for use in their own programs. The following list should not be
interpreted as an official endorsement of any particular equipment or vendor. Volunteers are encouraged to
explore all stream temperature monitoring equipment options available to them and select the equipment that
works best for their budgets and/or individual monitoring needs.

e Stream Temperature Loggers:

o Onset HOBO Water Temperature Pro v2 Data Logger - U22-001 --
http://www.onsetcomp.com/products/data-loggers/u22-001

o Data Download Shuttles* (include the required coupler and USB connection cables)

o HOBO® Waterproof Shuttle - U-DTW-1 --
http://www.onsetcomp.com/products/communications/u-dtw-1

o Optic USB Base Station - BASE-U-4 --
http://www.onsetcomp.com/products/communications/base-u-4

*NOTE: You will only need one of the above options. The waterproof shuttles allows for
downloading the loggers in the field without needing to bring a laptop to the monitoring station;
the base station option will require that you bring a laptop with you to the field if you wish to do
field downloads during your site visits.

e Logger Software:
o HOBOware Pro Mac/Win Data Logger Software
= CD version - http://www.onsetcomp.com/products/software/bhw-pro-cd

=  Download version - http://www.onsetcomp.com/products/software/bhw-pro-did

o Field/QC Thermometer:

o Digi-Sense Waterproof Digital Thermometer --
http://www.coleparmer.com/Product/Digi_Sense Calibrated Remote Probe Digital Thermomet
er Waterproof/WU-90205-22?SearchTerm=WU-90205-22

PROGRAM CONTACT INFORMATION:

Meghan Lally

Volunteer Stream Temperature Network Coordinator
CT DEEP Bureau of Water Protection & Land Reuse
79 Elm Street, Hartford, CT 06106-5127

(860) 424-3061
DEEP.VolunteerWaterMonitoring@ct.gov

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual Last Revised 04/25/17 Page 3


http://www.onsetcomp.com/products/data-loggers/u22-001
http://www.onsetcomp.com/products/communications/u-dtw-1
http://www.onsetcomp.com/products/communications/base-u-4
http://www.onsetcomp.com/products/software/bhw-pro-cd
http://www.onsetcomp.com/products/software/bhw-pro-dld
http://www.coleparmer.com/Product/Digi_Sense_Calibrated_Remote_Probe_Digital_Thermometer_Waterproof/WU-90205-22?SearchTerm=WU-90205-22
http://www.coleparmer.com/Product/Digi_Sense_Calibrated_Remote_Probe_Digital_Thermometer_Waterproof/WU-90205-22?SearchTerm=WU-90205-22

LOGGER QC CHECKS

Equipment Needed:

HOBO Prov2 water temperature logger

Computer with HOBOware Pro and Microsoft Excel software installed
HOBO waterproof shuttle or Optic USB Base Station
HOBO Prov2 coupler for shuttle/base station

Large cooler with lid

Mesh or perforated plastic basket

Plastic bin (Small enough to fit inside basket)

Weight

Four rocks or other solid objects approximately 1-inch tall
Ice

Water

Clock/watch

Thermometer

QC Check Log (Appendix A)

NOTE: The logger QC check procedure is a two-day process. During Day 1 the volunteer will
prepare the ice bath and schedule the loggers to launch. During Day 2 the volunteer will conduct
the actual QC test.

DAY 1
STEP 1: PREPARE THE ICE BATH

1.

2
3.
4.
5

DAY

Place the four rocks (or other solid objects, approximately 1-inch tall) on the bottom of the cooler. Place
the basket on top of the rocks/objects so that the basket sits at least 1-inch above the bottom of the cooler,
and the top of the basket is at least 1-inch below the top edge of the cooler.

Fill the cooler and the basket with ice. Add cold water to fill the cooler approximately % full.
Add the weight to the plastic bin and fill with ice. Place the bin on top of the basket in the cooler.
Add additional cold water to bring the water level to just below the top of the basket.

Secure the cooler lid in place and store overnight in a cool location.

2

STEP 2: CHECK THE ICE BATH

1.

Remove the lid from the cooler; ensure that the cooler contains a mixture of both ice and water and
measures 0.0C. (If there is no ice present in the cooler or the temperature measures warmer than 0.0C,
add additional ice — draining off water as needed to make space - and allow the cooler to sit for several
more hours until it consistently measures 0.0C.)

Using the thermometer check the cooler ice water temperature in several locations. The temperature
should be 0.0C in all locations checked. If the contents of the cooler are not a uniform 0.0C, mix the ice
water and allow the cooler to sit for several more hours.

3. Secure the lid of the cooler back in place.
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STEP 3: SCHEDULE THE LOGGERS TO LAUNCH
1. Turn on your computer; open HOBOware Pro software.

2. Attach the waterproof shuttle/base station to the computer using the USB cable. Attach the Water Temp
Pro v2 coupler (blue label, COUPLER2-C) to the base station/shulttle.

Record the serial number and logger type (i.e. “ProV2”) of the first logger on the QC Check Log.

4. Insert the logger into the coupler so that the arrow on the logger aligns with the white arrow on the
coupler label. At the bottom right of the HOBOware Pro screen the message “1 device connected” should

appear. At the bottom left of the screen you should see your logger serial number displayed, e.g. “Dev:
HOBO U22-001 Water Temp, S/N: [Serial Number]”

|H HOBOware Pro \EI\EI

File Device Edit View Tools Window Help

SaasB-65-B-B- 0EBXAS kv

CANEBERITO=|?

Ready.

0

Dev: HOBO U22-001 Water Temp, S/N: 9715476 1 device connected

5. Set the logger to launch the next day at the time you wish to start your QC check:

a. Select Device > Launch from the menu options at the top of the main screen
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H HOBOware Pro

Launch...

GJ;J

2
2} Readout..,
L Status...

&l Stop..

File Edit View Tools Window Help

\

Ctrl+L

1 N
Ctrl+R
Ctrl+I
Chrl+ K

b. A “Select Device” pop-up window will appear. Select the HOBO logger with serial number you
recorded on your QC log and click “OK”. A “Launching logger...” message should display in
the lower left of your HOBOware window.

C. The “Launch Logger” pop-up window will open. Check that the serial number displayed is the
same as the number you recorded on your QC Log.

d. Record the Battery State displayed (e.g. “GOOD”) on your QC Log.

i. NOTE: If less than “GOOD” don’t proceed with the QC check; replace the logger with a
new unit or return the logger to Onset for battery replacement.

e. Change the Description field to the following format: [Serial Number] QC [MMDDYY]. For
example, for logger serial number 9715476 that will be checked on April 08, 2015, you would
enter “9715476 QC 040815

f. Set the Logging Interval to “1 minute”

g. Schedule the logger to Start Logging “On Date/Time” and enter the date and time that the QC

check will begin.

i. NOTE: The QC check should occur the day after the ice bath is prepared, and the logger
should be set to start logging at least one hour from the time that place it in the ice bath.
(This will allow the logger to acclimate to the ice water bath prior to the start of

recording.)

Launch Logger

=7

HOBO U22-001 Water Temp
9715476 QC 040815

/ Serial Number: 9715476

Deployment Mumber: 3

Battery State: \ly GOOD

Description:

Sensors

Configure Sensors to Log:

‘ 1) Temperature |<Enter label here>

-~

7 Filters...

=

Deployment

o 7 Add Interval

Logging Interval

-

1) :1 second

Samples Logs until

StartLogging: |OnDatefTime v ||04/08/15] [ »] [03:00:00 PM

¥

-~

[ Skip launch window next time

Cancel

] [ Delayed Start

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual

Last Revised 04/25/17

Page 6



h. Record the scheduled launch date in the “Date” column of the QC Log. Record the scheduled
launch time in the “Launch/Start Time & Temp” column of the QC Log.

i. Select the “Delayed Start” button at the bottom right of the pop-up window to complete the
launch. You may see a launch progress display similar to the following:

Launching Logger @

Logger is now set up for a delayed start. Do not unplug while logger is being configured.

Wrote 276 bytes of 368

At the conclusion of the launch you will see “Launch successful” displayed in the lower left of
the HOBOware window.

j. Disconnect the logger from the shuttle and set ot the side.
6. Repeat Steps 3.1 through 3.5 above for all other loggers to be QC checked.

STEP 4: PLACE THE LAUNCHED LOGGERS IN THE ICE BATH

1. Place the launched loggers in the cooler ice bath at least one hour before their scheduled launch
date/time.

a. Open the cooler and set the plastic bin filled with ice and the weight to the side.

b. Submerge all of the launched loggers, lens side facing down, into the ice water within the basket
in the cooler.

i. NOTE: Do not overcrowd the basket with loggers. There should enough space between
the loggers in the basket to allow ice water to flow freely between loggers. If you have
many loggers you may need to QC check your loggers in batches.

c. Place the plastic bin (with the ice and weight) on top of the submerged loggers, insuring all
loggers are completely submerged in the ice water bath.

d. Thoroughly mix the ice bath water around the plastic bucket.

e. Secure the cooler lid in place and let the cooler sit undisturbed in a cool location.

STEP 5: CHECK THE QC START TEMPERATURE

1. At the time the loggers are set to launch (i.e. begin recording data), use the thermometer to manually
check the temperature of the ice bath within the cooler. Check the temperature as close to the loggers as
possible, without disturbing the position of the loggers.

2. Record the temperature to the nearest 0.1C on the QC Log in the “Launch/Start Time & Temp” column —
e.g. “0.0C”

a. NOTE: If the ice bath temperature is not 0.0C then the QC check should be stopped, and the ice
bath corrected (i.e. add additional ice, mix more thoroughly) until it consistently measures 0.0C.
The QC process will need to be restarted from Step

3. Replace the cooler lid and let the loggers sit in the ice bath for 30 minutes.
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STEP 6: CHECK THE QC MID-POINT TEMPERATURE

1.

3.

30 minutes after the time the loggers were set to launch, use the thermometer to take a second manual
reading of the ice bath temperature. Again, check the temperature as close to the loggers as possible,
without disturbing the position of the loggers.

Record the time and the temperature to the nearest 0.1C on the QC Log in the “Mid QC Time & Temp”
column.

Replace the cooler lid and let the loggers sit in the ice bath for 30 minutes longer.

STEP 7: CHECK THE QC END TEMPERATURE & REMOVE LOGGERS FROM ICE BATH

1.

3.

60 minutes after the time the loggers were set to launch, use the thermometer to take a third manual
reading of the ice bath temperature. Again, check the temperature as close to the loggers as possible,
without disturbing the position of the loggers.

Record the time and the temperature to the nearest 0.1C on the QC Log in the “End QC Time & Temp”
column.

Remove the loggers from the ice bath.

STEP 8: DOWNLOAD THE LOGGER QC DATA

1.

Open HOBOware Pro on your computer. Create a folder on your computer to store your logger QC data.
It is recommended that you keep all of you logger downloads, QC files, site photographs, etc. in one
master folder on your computer and then have a “Stream Temperature QC Data Files” folder within that
master folder.

Create a subfolder within your QC Data Files Folder and name it “HOBO QC MMDDYY” (insert the
date of the QC check.)

Attach the logger to the base station/shuttle and wait for the “1 device connected” message to appear in
the lower right.

Select ‘Readout’ from the ‘Device’ menu. The ‘Select Device” pop-up window will open —
select the HOBO logger from the list and click “OK.”

When prompted, select ‘Stop’ to stop the logger from logging.

Stop Logger? EX

The logger is currently logging.
Do you wish to stop logging before reading out the logger?

| Don't Stop | i Stop |I| Cancel |

A “Save” pop-up window will open. Save the QC data file to the folder you created in step 8.2.
The File name should default to the Description you entered during step 3.5.e; if not name the
file “[Serial Number] QC [DDMMYY]”. Select .hobo as the file type if it is not the default.

A “Plot Setup” pop-up window will open. (Check that the description is the same as the
description you entered in step 3.5.e and the file name in step 6 above.)

a. Make sure the “Temp” series is selected and the units set to “C.” (If the “Batt” series is
checked, uncheck it.)
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b. Uncheck all events from the “Select Internal Logger Events to Plot” list.

c. Click “Plot”. A data table and plot of the QC data will open in the HOBOware window.

8. Select “Export Table Data” from the “File” menu to export the data as a .csv file. An “Export”
pop-up window will appear; make sure the “Temp” series is checked and click “Export.” The
default file name should be the same as the raw HOBO file (.hobo file) you named is step 8.6

above; save to the same location.

H HOBOware Pro

File Device Edit View Tools Window Help

A888B8-6B-B- 03880k

=8 EEH =5

Qe ElHEMI TO®®|?

#  Time, GMT-04:00

04/07/15 12:15:00 PM
04/07/15 12:16:00 PM
04/07/15 12:17:00 PM
04/07/15 12:18:00 PM
04/07/15 12:19:00 PM
04/07/15 12:20:00 PM
04/07/15 12:21:00 PM

N bW e

Temp, °C

-0.032
-0.032
-0.032
-0.032
-0.032
-0.032
-0.032

-

ona) (e

Details
[#-+~ Series: Temp, °C

-1.24

12:00:00 Pl
0407715 12:00:00 P GWT-04:00

9715476_QC_040815

12:20:00 Ph

12:40:00 P

01:00:00 Pl

o a
01:20:00 P 01:40:00 Pt
04/07/15 01:40:00 Ph GhIT-04:00

= Ready.

Dev: HOBO U22-001 Water Temp, S5/N: 9715476

1 device connected
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HOBOware Pro

Device Edit View Tools Window Help

) Open Datafile(s)... Ctrl+ 0
Merge Datafile(s)... I
Open Project... Ctrl+Shift+ 0
Plot/Export wireless data... Ctrl+Shift+Q
Recent Files L4
5 Close Ctrl+W
Close All Ctrl+Shift+W
Save Datafile... Ctrl+5
lm| Save Project... Ctrl+Shift+5
Import Text Data... Ctrl+T

Import Text File from HOBOlink...

Export Details...

2l  Export Table Data...

Page Setup...

Print Preview...
i Print...

Print Details...

Print Points...

Preferences...

Quit

Ctrl+E

Ctrl+P

Ctrl+Comma |

Ctrl+Q

9. Repeat steps 8.3 through 8.8 above for any remaining loggers that were in the ice bath.

STEP 9: CoMPILE THE QC .csV FILES INTO AN EXCEL SPREADSHEET

1. Open Microsoft Excel; open a new workbook. Save the file as “QC [DDMMY Y] Master File.”
(Example: QC 040815 Master File.xlIs). Save the file to the same folder as you saved the raw QC data
files in Step 8 above.

a.
b.
C.
d.

In cell 1A of the QC Master File enter the date of the QC check.

In cell 1B type “Serial #”

In cell 2A type “Time”

In cell 2B type the serial number of the first logger recorded on your QC log.

2. Starting with the first logger listed on your QC log, open the saved .csv file. The file should include a
Plot Title in the upper left with the file name you entered in step 8. Colum A will contain reading
numbers starting with #1, column B should contain date/time, and column C should contain temperature
readings in degrees Celsius.

a.

Note: If using an older version of Excel you may be prompted to interpret the delimitation of
the .csv file. Select “Delimited” and click “Next”. Check “Comma” off and click “Next”
again. Click “Finish.” When asked where do you want to put the data select “Existing
Worksheet” and type “=3A481" (no quotation marks) in the box. Click “OK”

3. Highlight and copy the date/time and temperature values in column B and C for the first 60 readings in
the .csv file. Click on cell A3 in the QC Master File and paste the copied data. Save the QC Master file
and close the .csv file for the first logger.

4. Open the .csv file for the second logger on your QC Log. Check to insure the first date/time are the same
as the first date/time in the QC Master File. Type the serial number of the logger into cell C2. Highlight
and copy the first 60 readings in the .csv file and paste to cell C3 of the Master File. Save the Master file
and close the .csv file.
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5. Repeat step 9.4 for each remaining logger on the QC log. Enter the logger serial number in row 3 of the
Master File and copying the corresponding temperature readings from the .csv file to the cell in row 4
beneath the serial number. Save the Master file; close any open .csv files.

H ©- a & - QA Master 040815 - Excel 7 B - O %
FILE HOME | INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  ACROBAT Meghan Ruta -
T Arial -l | == = % General A %Cnnditinnal Formatting = E““Insert - E - E‘Y*
. Itﬁ g~ B I U~ A o0 === - % -9% + [HiFormatas Table~ EX Delete ~  [@] - -
afe ~ SRR R W == S0 [ Cell Styles - ElFormat~ & -
Clipboard & Font M Alignment o MNumber Styles Cells Editing -
K70 v Jx v
A B C D E F & H J K L -
1 |4/8/2015 Serial #
2 |Time 9715468 10348789 10348790 9859182 9859184 |9937216 10122061
3 | 4/8/2015 12:15  -0.004 1.262 1235 0079 0024 -0.06 -0.032 Note: Data truncated in
4 | 4/8/2015 1216 -0.004 1.071 0.983 0079 0.024| -0.06  -0.032 middle to show
5 | 4/8/2015 1217 -0.004 0.88 077 0.079 0024| 0088  -0.032 .
6 |4/8/2015 1218 -0032 0715 0632 0079 0024 -0088  -0.032 formatting
7 | 4/8/2015 12:19  -0.032 0.605 0495 0079 0024 -0088  -0.032
8 | 4/8/2015 12:20  -0.032 0.495 0.412 0051  0.024| -0.088 -
9 | 4/8/2015 12:21  -0.032 0.412 0.329 0051 0.024 - -0.032
10 | 4/8/2015 12:22 0032 0.356 0.246  0.051 - -0.088  -0.032
11| 4/8/2015 12:23 -0.032 0.301 0.218 - -0.004| -0.088  -0.032
12 | 4812015 12:24 0032 0.246 63 0.024 -0.004| 0088  -0.032
13 | 4/8/2015 12:25  -0.032 - 0.135 0.024 -0.004 -0.088  -0.032
43 | 4/8/2015 12:65  -0.032 0.051 0.024 -0.004 -0.004 -0.088  -0.032
44 | 4/8/2015 12:66 -0.032 0.051 0.024 -0.004 -0.004 -0088  -0.032
45 | 4/8/2015 12:57  -0.032 0.051 0.024 -0.004 -0D.004 -0.088 -0.032
46 | 4/8/2015 12:58  -0.032 0.051 0.024 -0.004 -0D.004 -0.088  -0.032
47 | 4/812015 12:569 -0.032 0.051 0.024 -0.004 -0.004 -0.088  -0.032
48 | 4/8/2015 13:00  -0.032 0.051 0.024 -0.004 -0.004 -0088  -0.032
49 | 4/8/2015 13:01  -0.032 0.051 0.024 -0.004 -0D.004 -0088  -0.032
50 | 4/8/2015 13:02  -0.032 0.024 0.024 -0.004 -0D.004 -0.088  -0.032
51| 4/8/2015 13:03  -0.032 0.051 0.024 -0.004 -0.004 -0.088  -0.032
52 | 4/8/2015 13:04  -0.032 0.024 0.024 -0.004 -0.004 -0088  -0.032
53 | 4/8/2015 13:05  -0.032 0.024 0.024 -0.004 -0D.004 -0088  -0.032
54 | 4/8/2015 13:06  -0.032 0.024 0.024 -0.004 -0D.004 -0.088  -0.032
55 | 4/8/2015 13:07  -0.032 0.051 0.024 -0.004 -0.004 -0.088  -0.032
56 | 4/8/2015 13:08  -0.032 0.051 0.024 -0.004 -0.004 -0088  -0.032
57 | 4/8/2015 13:09  -0.032 0.024 0.024 -0.004 -0D.004 -0088  -0.032
58 | 4/8/2015 1310 -0.032 0.051 0.024 -0.004 -0D.004 -0.088  -0.032
59 | 4/8/2015 1311 -0.032 0.024 0.024 -0.032 -0.004 -0.088  -0.032
60 | 4/8/2015 1312 -0.032 0.051 0.024 -0.004 -0.004 -0088  -0.032
61| 4/8/2015 1313 -0.032 0.024 0.024 -0032 -0.004 -0088  -0.032
62 | 4/8/2015 1314 -0.032 0.024 0.024 -0.004 -0.004 -0.088  -0.032
63
B4 |MIN 0.0 0.0 0.0 0.0 0.0 -0.1 0.0
B5 |MAX 0.1 1.3 1.2 0.1 0.0 -0.1 0.0
66
RT -
QA Master 040815 ) 1 ’
READY FH M -— b+ 100%
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STEP 10: CALCULATE MAXIMUM AND MINIMUM VALUES FOR LOGGER QC DATA

=

e n

In cell A64 type “MIN”; in cell A65 type “MAX”.

Click on cell B64 and type “=MIN(B3:B62)” (do not type quotation marks); hit Enter.
Click on cell B65 and type “=MAX(B3:B62)” (do not type quotation marks); hit Enter.
Highlight cells B64 and cell B65. Left-click on the green box in the lower right of the highlighted

cells and drag it to the right to copy the formulas to any remaining logger data columns in the

worksheet.

5. Examine the minimum and maximum values for each logger.

a. Highlight any cells in row 64 (minimum values) that are less than -0.2C. Scroll to the top of
the corresponding data column of any highlighted minimum value cells and highlight the
logger serial number. Check “No” in the “QC Pass?” column of the QC Log for this logger
and write “Fail #1” in the Comments column.

b. Highlight any cells in row 65 (maximum values) that are greater than 0.2C. Scroll to the
top of the corresponding data column of any highlighted minimum value cells and highlight
the logger serial number. Check “No” in the “QC Pass?”” column of the QC Log for this
logger and write “Fail #1” in the Comments column.

c. For all remaining loggers on the QC log check “Yes” under the “QC Pass? “column. (These
loggers had readings that were all within the range of -0.2C to 0.2C.)

STEP 11: RePEAT THE QC CHECK FOR ANY LOGGERS THAT DID NOT PAss THE QC CHECK

1. Any loggers that did not pass the initial QC check must be rechecked before they can be considered
acceptable to use for stream temperature data collection. If a logger failed the initial QC check it
must pass two subsequent QC checks to be considered passing and usable. Any possible reasons for
the initial QC check fail should be noted on the QC log.

2. Loggers that fail a second QC check should be removed from circulation and returned to Onset (if
desired) for evaluation. (Note “Fail #2” in the comments column of the QC Log for the logger’s

second QC check.)

CT DEEP Volunteer Stream Temperature Monitoring Program

Temperature Data Logger QC Log - 2015 Volmon

Logger Serial # Logger Type Date State

Battery | Launch/Start
Time & Temp

“[__acrass?

Yes | No

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual
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LOGGER DELAYED LAUNCH

Equipment Needed:
e HOBO Prov2 water temperature logger
o Computer with HOBOware Pro and Microsoft Excel software installed
e HOBO waterproof shuttle or Optic USB Base Station
o HOBO Prov2 coupler for shuttle/base station

Launch Notes:

e If pre-calibration for the logger is within acceptable tolerance of the logger (i.e. +/- 0.2C),
program the logger for field deployment.

e |tisagood practice to set the delayed start date and time with enough buffer to ensure that the
first reading is a stable water temperature measurement.
STEP 1: UPDATE YOUR HOBOWARE SOFTWARE

1. Be certain to have the latest version of HOBOware® software. You can check for the latest
version www.onsetcomp.com.

STEP 2: CHECK THE LOGGER BATTERY STATUS

1. Open HOBOware Pro on your computer. Using the coupler, attach the logger to the base
station/shuttle and wait for the “1 device connected” message to appear in the lower right of the
HOBOware window.

2. Select ‘Status’ from the ‘Device’ menu. The ‘Select Device” pop-up window will open —
select the HOBO logger from the list and click “OK.”

|H] HOBOwWare Pro

File Edit View Tools Window Help

2} Launch... Chrl+L
2} Readout... Ctrl+R
L Status.. Ctrl+I

OI;JJ

&} Stop.. Ctrl+K
Manage Shuttle...
Manage HOBO Data Node Network...  Ctrl+Shift+H
Configure Modules/Ports... Ctrl+Shift+C
Manage U30
Lab Calibration...

Select Device... Ctrl+MN
Default Action

Utilities

3. The “Status” pop-up window will open and display device identification, details, and current
readings for the attached logger. Check to make sure the Battery State is “Good” and the
battery voltage is greater than 3.3V. Click “OK” to close the window.
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a. NOTE: The battery in the HOBO® Water Temp Pro v2 is a 3.6 V lithium battery. If
the battery falls below 3.1V, the logger will record a “bad battery” event in the data

file. If the data file contains “bad battery” events, or if logged battery voltage

repeatedly falls below 3.3 V, the battery is failing and the logger should be returned

to Onset® for battery replacement.

Status | 2|
Device Identification Device Details
/ Battery State: [y GOOD
Device: HOBO U22-001 Water Temp Memory Used: NOONOOOOON 0 0f 64 KB (1%)
SETCREETEE LRI LE Last Launched: 04/08/15 03:02:23 PM GMT-04:00
Corporation
Description: 9715476 QC 040815 DRI 2
Serial Number: 9715476 STIITIITENEE LT
Firrmware Version: 1,05 Current Status: Logger is stopped
Current States: Coupler Attached
Current Readings
l_] L Screen Refresh Interval: 115 sec
Number Measurement Value Units Label *
1 Temperature 22,585 =C
2 I Logger's Battery Voltage 3.48 I o
] 3

STEP 3: SCHEDULE THE LOGGER TO LAUNCH

1. Select ‘Launch’ from the ‘Device’ menu. The ‘Select Device” pop-up window will open —

select the HOBO logger from the list and click “OK.”

H HOBOware Pro
(,J;J b Launch...
=

b Status...
&

Readout...

Stop...

Manage Shuttle..,
Blanane HORO Nata Made bletaenrl

2. The “Launch Logger” pop-up window will open.

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual

File Edit View Tools Window Help

Ctrl+L
Ctrl+R
Cirl+1

Ctrl+
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a. Inthe Description field enter the name of the file that will store the data that the logger is
to record while out in the field. The following naming convention is preferred by DEEP:
“[Serial Number] [Season] [Year] Deployment”

i. NOTE: Do not include any site information when naming the logger file; this will
insure a logger can be used at any monitoring location and avoids the possibility
of accidentally placing a logger at the wrong site (i.e. at a site other than that
which is in the file name).

b. Make sure the “Temperature” sensor is checked off.
Set the logging interval to 1 hour.

d. Select “On Date/Time” from the “Start Logging” drop down menu. Enter the date and
time that you would the logger to start recording data.

i. NOTE: To prevent erroneous data at the start of the logger dataset, it is
recommended that you set the date/time to be at least several hours after you plan
to place the logger into the stream. This will allow the logger sensor to adjust to
in stream conditions prior to logging data. For example if you plan to set the
logger out on a Saturday morning, it is recommended that you set the logger to
start recording that evening or the next day.

Launch Logger @I

-

HOBO U22-001 Water Temp

Description: |9715476 Spring 2015 Deployment
Serial Mumber: 9715476

Stgtys.. | Deployment Mumber: 4

Battery State: W GOOD

Sensors

Configure Sensors to Log:

s

T Filters...

‘ /| 1) Temperature | <Enter label here>

Deployment

o r Add Interval

Logging Interval Samples Logs until -

1) | 1hour - 43474 5.0 years

Start Logging: | On Date/Time  ||04/10/15] E| 03:00:00 AM |5

Help Skip launch window next time | Cancel || Delayed Start |

e. A “Launching Logger” status bar may appear. When the logger is launched a
“Launch successful” message will appear in the bottom left of your screen.

3. Repeat steps 3.1 and 3.2 above for any additional loggers that need to be launched.

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual Last Revised 04/25/17
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LOGGER DEPLOYMENT

Equipment Needed:

One Per Monitoring Site:
a. Stream temperature logger (1 per site)
b. PVC tube with holes drilled — 4 holes around each end and two pairs of holes in the center
C. Heavy metal plate or other field weight (>10 Ibs)
d. Monitoring Site Log & Field Data Sheet (Appendix B)
Medium-sized Zip ties
Digital camera (or smart phone)
GPS Unit (or smart phone)
Surveyor’s flagging
Pencils

STEP 1: SECURE THE LOGGER IN THE LOGGER HOUSING

1. Before securing your logger in its housing, begin a new Monitoring Site Log & Field Data Sheet

(Appendix B); complete the “Site & Logger Details” section:
a. Record the Volunteer Group Information:

i. Record the name of the organization or group overseeing the stream monitoring program
that you are volunteering for (e.g. Volunteer Group Name).

ii. Record the name and phone number of the individual coordinating the volunteer group’s
overall stream temperature monitoring program (i.e. the Coordinator).

b. Record the Site Information:
i. Record the Stream Name in the “Stream” field.

ii. Leave the site number field blank; the volunteer program coordinator will assign each
monitoring site a unique site number for tracking purposes.

e For example, the Hop River Watershed Association might assign their 2015
monitoring locations on the Hop River HR-1, HR-2, etc.

iii. Record the town in which the monitoring site is located

iv. Provide a written description (Site Location) of the monitoring site. The site location
description should be filled in with a narrative description of the logger location. This
description should be detailed enough to allow another individual who is unfamiliar with
the area and the site to use a map to locate the stretch of river that the logger is located
in. Include relevant nearby landmarks such as road intersections, businesses, telephone
pole numbers, house addresses, etc. This description will be used by DEEP to assign
your monitoring site a location in the DEEP database.

v. Use a GPS unit or smart phone to collect and record the GPS location of your monitoring
site. (Note the location does not need to be the exact location of the logger but an
approximation of its location on the given stream reach.)

c. Record the Logger Details:

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual Last Revised 04/25/17
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i. Record the logger serial number and type (ProvV2 HOBO). NOTE: Read the serial
number directly from the logger; if forms were filled out in advance, check that the
logger serial number on the form matches that of the logger you are about to deploy in
the stream.

ii. Record the scheduled launch date and time, and note who performed the launch.

d. Secure the logger inside the PVVC tube by inserting the logger inside the tube. Using a zip tie,
loop the tie through one of the center holes in the tube, then through the tab on the logger, and
then back out the second center hole in the tube. Secure the tip tie firmly. Loop a second zip tie
through the tube around the bottom end of the probe and secure firmly.

2. Secure the PVC tube (with logger now firmly secured within) to a heavy weight (i.e. metal plate, window
weights, or other heavy metal object) usmg additional 2|p ties and cable/parachute cord if needed.

Examples of loggers secured within PVC tube using zip ties and{fhie'n-‘attaéhed toa heavy mefal eight.
Shown is a railroad tie (left) and old window weights (right).
3. Provide a description of the housing materials (e.g. “Black PVC tubing attached to metal plate”) in the
space provided in the “Installation Log” section of the Monitoring Site Log & Field Data Sheet.

CT DEEP Volunteer Stream Temperature Monitoring Program
MONITORING SITE LOG & FIELD DATA SHEET

pP Vivr &

VOLUNTEER GROUP NAME: e ciATI O
Coordinator Name: Mes HEN LA Phone: (Bleo) 123 » 43
f 7
SITE INFORMATION: 3 ) |
Stream: Lt: P _L\vd site#: WEg ~| Town: \,‘\:If.n/{' [
Site Location*: 3oLt vpd heam l-l-rf‘f“‘CC Ld cvneeird . Ad acen riant 5 ﬁr’ fad |
GPS Information: Latitude* " Longhude: ~71 . A& 5t v

*Location description should enable DEEP staff to find the site where the logger is located on a map. (i.e. '100ft downstream of Thompson Drive crossing,
across from the ABC Landscaping Business')

LOGGER DETAILS: I~
Logger Serial #: {} 71 N “} 7@« Type (circle): @Q/Z HOBO. TidbiT

]
Scheduled Launch Date/Time*: 04 | 10 1. 00 Launched By: M | L Aeid
*Loggers should be set to collect HOURLY readings (i.e. log, terv a’ 1 hour) in degrees CELSIUS, starting on a hour mark

CT DEEP STAFF USE ONLY
PLACE SITE INFORMATION STICKER HERE

_|Logger Placed in Stream (Deploy): Date: _ 0% M| 20iF
Volunteer Names (First & Last): Patace Lally 4 Shay bally

Description of housing materials used to protect logger (i.e. PVC’ pipe attached to metal pI‘ate, etc.) and how logger was secured to
Bite (i.e. staked mto the streambed, tethered to a nearby tree, etc )
L]

Blaew PVC Mibingd abttaclihed w! 2w bvel 10 "L dhaped et Plakc
TAKE PHOTOS OF: Mpstream Area [S0ownstream Area [SCocation of Logger I

Time: _12° 00
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STEP 2: LOCATE YOUR INSTALLATION SITE

1. Identify where exactly you will place the logger on the stream bottom.

a. Locate an area at your site that is unlikely to be highly trafficked by the public, or if this is not
possible, that will not be highly visible to the public.

b. Select an area that is in a deeper hole or run (not too deep — you need to be able to retrieve the
logger!) or that is unlikely to go dry during the low-flow summer period. The location should be
in an area of the stream that will remain wet throughout the summer — avoid the edges of shallow
streams and sand/gravel bars.

2. Remove all large substrate from the point where you will be placing the logger.

3. Place the logger/housing/weight setup on the stream bottom so that the PVC tube is oriented to allow
water to flow through both ends of the tube.

4. Build a rock enclosure around the HOBO by placing large rocks around and over the HOBO housing.
Place the rocks carefully to avoid dropping rocks onto the HOBO housing; not doing so could result in a
broken logger. Build up the enclosure enough to protect the HOBO without unnecessarily drawing
attention to the location. (This will both protect the logger from movement during high flow events and
shield it from sunlight while in the stream.)

5. Use surveyor’s flagging to mark the stream bank on one or both sides of the logger to help locate the
logger as needed while deployed or during retrieval. (Use discretion if placing a logger in a highly
trafficked area — you may need to strategically place your flagging so that you can later locate your logger
but so that it will not direct a curious visitor directly to the logger during your absence.)

Surveyor’s
flagging

Logger located
under rock pile
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STEP 3: TAKE SITE PHOTOS

1. Take a photo standing at the logger location and facing upstream. (When facing upstream you will be
facing the direction that the water is flowing from.) Try to capture as much of the surrounding stream
banks and land use as possible. Check off on the field data form that you took an ‘Upstream Area’
photo.

2. Remain at the logger location and turn 180 degrees so that you are facing downstream. (When facing
downstream you will be facing the direction that the water is flowing towards.) Take a photo of the
downstream area, again trying to capture as much of the surrounding stream banks and land use as
possible. Check off on the field data form that you took a ‘Downstream Area’ photo.

3. Take additional photos of the logger location.

a. Itis recommended that you take at least one photo of a volunteer standing next to the logger
pointing down at the logger.

b. Try to capture any unique features mentioned in the site description or area map when taking
photos. The photos should be taken from a far enough distance to capture nearby landscape
features and flagging so as to help other volunteers (or you) locate the logger in several months
when you return to download the data or retrieve it.

c. Consider taking the photos from the direction that you will be approaching the stream when you
return to check on or retrieve the logger.

d. Refer to Appendix C for additional photo guidance.
e.  When done, check off on the field data form that you took ‘Location of Logger’ photos.

An example () photo showing the location of a oggertt was just installed at a site in the field.
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STEP 4: COMPLETE THE “DATA LOGGER INSTALLATION/RETRIEVAL FORM”

1. Complete the remaining portions of the “Installation Log” section of your datasheet:
Record the date and time that the logger was placed in the water/stream.
Record the full names (first and last) of all volunteers that are in the field deploying the logger.

The description of logger housing materials should have been recorded in Step 1.1 above.

2 o T ®

The photo boxes should have been checked off in Step 1.3 above.

e. Provide a detailed description of where the logger is located within the stream to help volunteers
locate the logger in the future. Note how far it is and in what direction from easily identified
features such as large boulders or trees, road crossings, or other unique landscape features.

f. Sketch a map of the stream reach in which the logger was deployed. Be sure to note the position
of the logger as well as any landscape features noted in your written description of where the
logger is located.
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CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual

CT DEEP Volunteer Stream Temperature Monitoring Program
MONITORING SITE LOG & FIELD DATA SHEET

SITE & LOGGER DETAILS:
VOLUNTEER GROUP NAME: o Pavr & Warreskep AsSbenrond

Coordinator Name: Megoan LA o Phone: (Bo) 123 - 45T
Sitew: W =) Town:  PAnpwe G, |

Siveum: hhp Piwee

Site Location*: [/ -
GPS Information: Latitude’ Longftude: =71 . 9& 2548
*Location descripbon should enable DEEP stalf to find the site where the loggeris located on @ map. (1.e '100f of Thomp Dnve 9.
across from the ABC Landscaping Business’)

L ER DET, A P P

Logger Serial #: 971 S 47L Type (circle): (Lrov2HOBO)  TidbiT
Scheduled Launch Date/Time*: 64‘@1.(' (4 2% ») L hedBy: M, LA/
“Loggers should be set to colect HOURLY readings (i.e. logging inicival = 1 hour) in degrees CELSIUS, starting on a@ hour mark }

INSTALLATION LOG (Complete when placing logger into stream):

Logger Placed in Stream (Deploy): Date: O%] 9] 2015

Volunteer Names (First & Last): Prrnce Lolly 4 Sha o Lally
- f -

Description of housing materials used to protect logger (i.e. PVC pipe attached to metal plate, etc.) and how logger was secured to

Time: _12° 00

site (i.e. staked into the bed, tethered to a nearby tree, o’tc.): A R

Blasy Pve hibing abtacihed ! 2w ive? 1o “L dhgoed aetnl Plakc
~, T -

TAKE PHOTOS OF: deamm Area [FOownstream Area ) [SCocation of Logger

DESCRIBE IN DETAIL WHERE THE LOGGER WAS PLACED IN THE STREAM (L.E. INSTALLED).

(Refer to or easily identified nearby fe when to help other volunteers iocate the logger during retnieval )

Adjacers rght bndge wirng wait [ facir s clownihean ) wnédes
J . ! v ! \ / = ;

(Avde rock i regre x croit e | ;,r 2o f+ ﬂuur waa tf [/ Sheany calyc

’_./:{.:" ~q o " hee dweslivy gertd JHcdhm
JSKETCH A MAP OF THE AREA WHERE THE IiOGGER WAS PLACED IN THE STREAM.
Your map should include any landmarks noted in your description above. Place an "X where the logger is located in the stream
CENTER CHANNEL upsrRE}M
e TR TS Y {
& H-(;xcf',(t E\_:' pr":“\( b

— \ ol ™

Aaf
o
: A al ¥
: T I x \ SN

CT DEEP STAFF USE ONLY
PLACE SITE INFORMATION STICKER HERE

o3)s
wghan Lally

A

Post-Retrieval QC Check:

QC Date
QC By

QA Result (Pass/Fail):

.{

' ) 4 > :
- h"' \ 5 \ S

' &

p~)

5

=4

2

Q

(4

g

o

Temp (°C) Voluntr Name 5

[os [laz | s teliqy 1|3
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FIELD TEMPERATURE CHECKS

Equipment Needed:
e Monitoring Site Log & Field Data Sheet (with deployment information)
o Digital camera
e Pencil
e Thermometer

Field temperature checks are not required by CT DEEP but do serve as a valuable quality control check
on your logger data. Field checks also provide a valuable opportunity to check on your logger to make
sure field conditions have not changed since the logger was first deployed (i.e. the logger is still
submerged during low flow period, the logger has not been moved or tampered with, etc.). If volunteer
groups have the resources to do so, it is recommended that field temperature checks be conducted once
per month while the logger is deployed. CT DEEP suggests that groups conduct a minimum of one
check during deployment, especially for sites being monitored for the first time. (There is no
recommended maximum for the number of field checks; the more the better!)

IMPORTANT NOTE: The goal of the field temperature check is to collect a manual reading to
compare to the data logger reading. The data logger was programmed to record temperature at
hourly intervals (e.g. 12:00, 13:00, 14:00, etc.). Stream temperature can vary significantly over the

course of an hour (i.e. from 12:00 to 13:00); therefore the most valuable field temperature checks will

be those that are conducted on or near an hour mark (i.e. on or near a logger data point.)
STEP 1: LOCATE YOUR LOGGER & TAKE SITE CONDITION PHOTOS

1. Use the Monitoring Site Log & Field Data Sheet that was completed during logger deployment along
with the logger deployment site photographs, to locate your stream logger.

a. NOTE: If any site conditions have changed since the logger was first deployed, be sure to update
the descriptions and map on the Monitoring Site Log & Field Data Sheet to reflect these changes.

This will assist with locating the logger for retrieval.
2. Following the guidance in Appendix C, take photographs to document the upstream conditions,
downstream conditions, and logger location during the time of your field temperature check.
STEP 2: TAKE A MANUAL STREAM TEMPERATURE READING
1. Without disturbing the logger or the surrounding rock pile, place the field thermometer in the stream,
underwater and as close to the logger as possible.

a. Take care that your hand is not touching the thermometer probe and that you are standing to the

side or downstream of the thermometer so as not to influence the flow or temperature of the water

passing by the thermometer.

b. The thermometer should be held within the water column and not be allowed to sit on the stream

bottom or touch any materials in the stream (e.g. rocks, woody debris).

2. Wait 30 seconds, or longer if needed, to allow the thermometer reading to stabilize.
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a. NOTE: stream temperature will vary slightly across the water column so it is unlikely that your
temperature will reach a single constant value; wait until the thermometer displays shifts in
temperature within 0.2C of each or less.

3. In the “Field Temperature Checks” section of your datasheet, record:
a. The date and time of the manual temperature reading (to the nearest minute)
b. The manual temperature reading (in degrees Celsius to the nearest 0.1C)
c. The name of the volunteer(s) that conducted the field temperature check.

TAKE PHOTOS OF: VMpstream Area [SHOownstream Area [SCocation of Logger
DESCRIBE IN DETAIL WHERE THE LOGGER WAS PLACED IN THE STREAM (I.E. INSTALLED).
(Refer to unusual or easily identified nearby features when ible to help other locate the logger during retrieval )
Adiacers right | ,.*‘,gr' L i gl e w163 4 N alal
f'ﬂ'.i(‘ rock. i il:'. XA iely 2o ff fr\:n'r e U iy el
4 / v

elided e

A

:’ i hed Fwesll r;iua,; \
SKETCH A MAP OF THE AREA WHERE THE LOGGER WAS PLACED IN THE STREAM.

Your map should include any landmarks noted in your description above. Place an "X" where the logger is located in the stream.
CENTER CHANNEL UPSTRE(AM

N ™~
— - e bom . { =
e rdier B Yoricda £ s 35
g 2 = = \‘\ (’ e N .::
Ay \ o
\ A Ll - 3 S 3 >
7 / D) \\ P NS
) \ o B &
s = > \ Z e
Ao ~ % ' z 2
) At — = & W 56 &
¢ “‘5 Y T ] W o K
/ aadé | 1 % < 3
AP / zoft ~ | ke AL C r x ‘E @
/ -~ \
v - } (, - _ C A Ban - E g - i::
\ Z 22 2
X1l
CENTER CHANNEL DOWNSTREAM 8838
\ X A |
Date Time Temp (°C) Volunteer Name Date Time Temp (°C)| Volunteer Name
cslichis i3:co 0-g Zialld aps s g:co 9.z | S iajly >
0P 45 digo 2¢.9 2ially HJO03) 5 g:-oc -4 | & rally] =
02423 /1 Py . @& 2. L]l 03/iz[i5— cly 5’ /4, 2 2 Lol 3
RETRIEVAL 8 AL DOWNLOAD LOG o
mﬂmu—mn—“‘ﬂ-‘“u. AVE] I 5
— 2
x o ~
Logger Serial #: 471547 Type (circle): FioVZHOBO  TidbiT S 2 g
3]
Volunteers (First & Last): )ha\/ Lally ¢ rzz/ Lally £ 5 £
L J7 7 s o 3
ogger Found Out of Water? Yes(tlo/ Signs of Tampering? Yes @ > Buried in SandlSedlment? Yes) No o g >
Comments: (s Foury - 5 2 c%
a4 > e g 7 =
Download Date: (¢ /(,/ / l, Download By: [}7(‘ hran Lall v x §' 2 . %
Download Time: /2 4 7 Download Ct fGles Saved To” &uf(/.h)'l’\fl O S0 &
Ao loads” fidee g ac05 )

Send completed forms to: Meghan Lally, WPLR Monitoring Assessment Program, 79 Elm Street, Hartford, CT 06108-5127 or meghan lally@ct.gov. Call
860-424-3061 with questions. Last revised 04/08/2015
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LOGGER RETRIEVAL

Equipment Needed:

Digital camera (or smartphone)

GPS Unit (or smartphone)

Pencils

Monitoring Site Log & Field Data Sheet (with deployment and field check information)
Wire cutters or heavy scissors

Ziploc bags

Manila tags

Sharpie marker

Cooler with ice

STEP 1: LOCATE YOUR LOGGER
1. Using the Monitoring Site Log & Field Data Sheet details and map along with your deployment site
photographs (and field check photographs if applicable), locate your stream logger.
2. Check to see if the logger appears to be out of the water, buried in sediment, or otherwise disturbed; if so
take a photograph of the logger as you found it before moving the logger.
STEP 2: TAKE A MANUAL FIELD TEMPERATURE READING & REMOVE LOGGER FROM STREAM
1. Without disturbing the logger, place the field thermometer in the stream, underwater and as close to the
logger as possible.

a. Take care that your hand is not touching the thermometer probe and that you are standing to the
side or downstream of the thermometer so as not to influence the flow or temperature of the water
passing by the thermometer.

b. The thermometer should be held within the water column and not be allowed to sit on the stream
bottom or touch any materials in the stream (e.g. rocks, woody debris).

2. Wait 30 seconds, or longer if needed, to allow the thermometer reading to stabilize.

a. NOTE: stream temperature will vary slightly across the water column so it is unlikely that your
temperature will reach a single constant value; wait until the thermometer displays shifts in
temperature within 0.2C of each or less.

Remove the logger and protective housing from the stream.

4. Record the date, time and temperature on the Monitoring Site Log & Field Data Sheet at the top of the
“Retrieval and Final Download Log” section.

5. Use a pair of wire cutters or heavy scissors to remove the logger from the protective housing. Check the
logger serial number; record this number and the logger type on the datasheet.

a. NOTE: DO NOT assume it is the same logger you deployed — check and record the actual
number on the logger.

6. Record the names (first and last) of all volunteers involved in logger retrieval.
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7. Indicate (yes/no) whether the logger was found a) out of the water, b) buried in sand/sediment, or c)
otherwise tampered with. If you answered yes to any of these provide additional information in the
comments section of the datasheet.

8. If you have a waterproof shuttle (or brought a laptop with you to the monitoring location) download the
logger data to your shuttle/laptop and record the download information (i.e. date, time, by, comments) on

the datasheet.

/ N i‘) \ 2
/ | = S
/ s g

o ~

. 2
- ol o =
¥ Q w
f ) 3
f f ’ 5 2
=z AP » § a
£ s =
¢ 8 = 3
e 00
g O 0O <
CENTER CHANNEL DOWNSTREAM a OOCC
Date Time Temp (°C) Volunteer Name Date Time Temp (°C)| Volunteer Name
esichis i3:0¢ -9 o balld als s $:co 19. Z S tejlo
- > T L/ =4 -
203 20 .C W/0A) £

Logger Removed from Stream: Date: £4]0i1//le Time:_ 0% -/3 Temp (C): /42
¥ :

LOGGER QC CHECK INFORMATION - VOLMON COORDINATOR USE ONLY

u
a - [}
Logger Serial #: 47i5 47 ‘ Type (circle): FroV2 HOBO TidbiT 2
= P 211 c o Lall (3]
Volunteers (First & Last): NAY Lally § (a ;ALY 0 =
e\ ' e~ 7 P g >
Logger Found Out of Water? Yes( No_ Signs of Tampering? Yes /(No Buried in Sand/Sediment? ’\lves I No £ 5
- o 53 - 2 - - [ 1]
Comments: H,y{, vkimma bely bald of PVC Ndle found bundd bdar (el Ll £ o
) { 4 7 - { '/’l ) -‘ i« ) 3 IL / L [ 71 [ [4 ” E ;
i == = | g B
Downioad Date: JC1 ] AN XA v s =3
Download Time: (2444 Download Comments: Gles Saved o Y20ily Spring ® 3 g i
Adouniloads” foidex ! = . G0 C

Send completed forms to: Meghan Lally, WPLR Monitoring Assessment Program, 79 Elm Street, Hartford, CT 06106-5127 or meghan lally@ct.gov. Call
860-424-3061 with questions. Last revised 04/08/2015

STEP 4: LABEL AND PACKAGE YOUR LOGGER FOR LATER DOWNLOAD

1. Attach a manila tag to the logger. Use a sharpie marker to record the following information on the label:
a. The stream name and monitoring location description
b. The logger serial number and type (read directly from the logger not your datasheet)

c. The date and time the logger was removed (Should correspond with what you recorded on the
datasheet)

d. The name of the individual(s) that retrieved the logger
2. Place the labelled logger into a plastic zip lock bag and place it into your cooler with ice for transport
back to your lab/office.
STEP5: TAKE UPSTREAM AND DOWNSTREAM SITE PHOTOGRAPHS

1. To document flow and site conditions at the time of logger removal, stand at the location
where you removed the logger, and take a photograph facing upstream and then a second
facing downstream. (Refer to Appendix C for site photograph guidance.) .
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LOGGER DOWNLOAD

Equipment Needed:

Monitoring Site Log & Field Data Sheet (with deployment and retrieval information)
HOBO Prov2 water temperature logger

Computer with HOBOware Pro and Microsoft Excel software installed

HOBO waterproof shuttle or Optic USB Base Station

HOBO Prov2 coupler for shuttle/base station

Download Notes:
e To avoid data loss, it is recommended that loggers be downloaded as soon as possible after retrieval.

e Loggers that were launched using a new version of software than the one used to attempt download may
give a “logger header corrupt” or similar error message. Prior to downloading, be certain to have the
latest version of HOBOware® software. You can check for the latest version www.onsetcomp.com.

o The following instructions are for download directly to a computer. If using a waterproof shuttle to
conduct field downloads (i.e. to temporarily store data to the shuttle memory), please refer to the
manufacture’s guidance for instructions.

VERY IMPORTANT: If you receive an error message when downloading, DO NOT agree to reset the logger —
this will DELETE all data off of the logger. Check that you are using the latest version of HOBOware; update
if available and try again. If the error message still persists contact the logger manufacturer (i.e. Onset) to
discuss options.

STEP 1: CREATE A FOLDER ON YOUR COMPUTER TO STORE THE DOWNLOAD DATA

1. Create a folder on your computer to store your logger data. It is recommended that you keep all of you
logger downloads, QC files, site photographs, etc. in one master folder on your computer and then have a
download folder for each year/season within that master folder. CT DEEP uses the format
“[Season][Year] Downloads” (e.g. “Spring 2015 Downloads™) to name our download folder.

STEP 2: DOWNLOAD THE LOGGER DATA

1. Open HOBOware Pro on your computer. Attach the logger to the base station/shuttle and wait for the “1
device connected” message to appear in the lower right.

2. Locate the Monitoring Site Log & Field Data Sheet for the first logger you wish to download. Make sure
the logger serial number matches the serial number recorded in the “Retrieval and Final Download”
section of the datasheet.

3. Select ‘Readout’ from the ‘Device’ menu. The ‘Select Device” pop-up window will open — select the
HOBO logger from the list and click “OK.”

4. When prompted, select ‘Stop’ to stop the logger from logging.
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http://www.onsetcomp.com/

Stop Logger?

l The logger is currently logging.

Do you wish to stop logging before reading out the logger?

’Don'tStop]i Stop ]I[ Cancel |

=

5. A “Save” pop-up window will open. Save the logger data file to the folder you created in Step 1 above.
Rename the file using the following naming convention, “[Logger Serial Number]_[Stream
Name]_[Site#]_[Town]_[LaunchDate] @[LaunchTime]-[Retrieval Date]@[Retrieval Time].” This
naming convention will help you quickly locate information when processing the file in the future. Use
military time (e.g. O to 24 hour clock) to avoid a.m. vs p.m. time confusion.

a. For example, for a logger with the serial number 10332636 deployed in the Mallory Brook at site
MB-1 in Barkhamsted on May 7, 2014 at 4:00p and retrieved on September 3, 2014 at 10:28a, the
file name would be:
“10332636_MalloryBrook_MB-1_Barkhamsted_040714@1600-090314@1028.”

6. A “Plot Setup” pop-up window will open.

a. Make sure the “Temp” series is selected and the units set to “C.” (If the “Batt” series is checked,
uncheck it.)

b. Click “Plot”; a data table and plot of the logger data will open in the HOBOware window.

H HOBOware Pro

File Device Edit View Tools Window Help

AASSD-5B-B- 088K B0k

[= =] =]

a2l TO®=|?

# Time, GMT-04:00 Temp,

=

Coupler Detached  Coupler Attached

Host Connected

Stopped  End Of File

& Event Type: Coupler Detached
[~ Event Type: Coupler Attached
Event Type: Host Connected
[#- Event Type: Stopped

[#-4% Event Type: End Of File

bl 05/07/14 04:00:00 PM 9.608 Logged a
2 05/07/14 05:00:00 PM 8.632
3 05/07/14 05:00:00 PM 9.808
K 05/07/14 07:00:00 PM 9.509
5 05/07/14 08:00:00 PM 8.336
6 05/07/14 09:00:00 PM 8.040
7 05/07/14 10:00:00 PM 8.717 il
cin7ita 14 i 4
= 2 o 2
e 10332636 MalloryBrogk MB-1 Barkhamsted 2
Details
[#-~ Series: Temp, °C —Temp, °C

& Coupler Detached
¥ Coupler Atached
# Host Connected
© Stopped

% End OF File

L oL 2

0501114
05/01/14 12:00:00 A GMT-04:00

T
0em14

T
0714

T T 1
[ERIRES oaning 100114
10/01/14 12:00:00 A\ GMWT-04:00

rﬁ Readv.
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7. Select “Export Table Data” from the “File” menu to export the data as a .csv file. An “Export” pop-up window
will appear. Make sure the “Temp” series is checked; uncheck the remaining series and click “Export.”

|H| HOBOware Pro
Device Edit View Tools Window Help

] Open Datafile(s)... Ctrl+ O
Merge Datafile(s)...
Open Project... Ctrl+Shift+ 0
Plot/Export wireless data... Ctrl+Shift+Q
Recent Files L4

&5 Close Ctrl+W
Close All Ctrl+Shift+W
Save Datafile... Ctrl+5

lm| Save Project... Ctrl+Shift+5
Import Text Data... Ctrl+T
Import Text File from HOBOlink...
Export Details...

(£l  Export Table Data... Ctrl+E
Page Setup... <
Print Preview... \

i Print... Ctrl+P
Print Details...
Print Points...
Preferences... Ctrl+Comma
Quit Ctrl+Q
Export
‘@A}I (O] Mone LWH _ o _
Click column header to sort on field. Drag individual rows to desired order.
Select Measurement Units SN Label
e - (S A
[l Coupler Detached
[l Coupler Attached
[l Host Connected
| Stopped
[l End Of File

Cancel ][ Export...

8. A “Save” pop-up window will open.

a. Save the file to the downloads folder you created in Step 1 above.

b. The file name should default to the name you assigned it in Step 2.5 above, but if not
again name the file using the convention, “[Logger Serial Number]_[Stream
Name]_[Site#]_[Town]_[LaunchDate] @[LaunchTime]-[Retrieval Date]@[Retrieval Time].”

Select “.csv Files” as the file type.
d. Click “Save”

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual Last Revised 04/25/17 Page 28



[H] save ==

Save in: Spring 2015 Downloads - ¥ e Ev

e~
Recent Items

Desktop

My Documents

A

-

Computer
=
m File name: 10332636 _MalloryBrook_MB-1_Barkhamsted_0407 14@ 160
Network Files of type: | sy Files - Cancel

STEP 3: ORGANIZE THE .CSV FILES INTO AN EXCEL SPREADSHEET FOR SUBMISSION TO CT DEEP

1. Use Windows Explorer to locate the .csv file you created in Step 2 above. Double click on the file to
open it in Excel. Save the file with the same name but as an Excel Workbook.

a. Note: If using an older version of Excel you may be prompted to interpret the delimitation of
the .csv file. Select “Delimited” and click “Next”. Check “Comma” off and click “Next”
again. Click “Finish.” When asked where do you want to put the data select “Existing
Worksheet” and type “=3A481" (no quotation marks) in the box. Click “OK”

2. The file name should be displayed at the top of your Excel window — you will be able to use this as a
convenient “cheat sheet” to clean any ‘tails’ of erroneous data off the ends of your data set.

a. Check the Monitoring Site Log & Field Data Sheet to insure the logger was deployed (put
into the stream) at a date and time several hours earlier than the launch date and time.

i. If the logger was launched (i.e. started recording data) before it was deployed, then the
first few rows of data will need to be deleted as these were not actual stream temperature
data. In this case (i.e. a launch prior to deploy scenario), add 12 hours to the deploy date
and time and delete all data prior to this date and time.

b. If the logger was launched after it was deployed, check to make sure the first data point (e.g.

the first row of data) corresponds with the launch date and time noted on the Monitoring Site
Log & Field Data Sheet. (If not you will have to determine why there is a discrepancy and

take corrective actions accordingly.)
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c. Determine the time the logger was removed from the stream. This should be noted as the final
date and time in the file name as well as in the ‘Retrieval & Final Download Log’ portion of the
Monitoring Site Log & Field Data Sheet. Round the removal time down to the closest hour and
then subtract one additional hour; delete all rows of data after this time on the retrieval date.
Save the file.

i.  For example if the logger was removed at 09:13 on 04/05/15, you would round down to
9:00a and then subtract one hour for a final time of 8:00a and delete all data recorded
after 8:00a on 4/5/15.)

3. Your Excel file should look similar to the following, with the plot title in cell Al containing the file name.
Columns B and C contain the date/time and temperature readings recorded by the logger respectively, and
column A indicates the numerical order of the data points recorded.

H a & - 10332636_MalloryBrook_MB-1_Barkhamsted_040714@1600-090314@1028 - Excel ? B - O %
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Meghan Ruta -
dI-D ,x\ Calibri Ax 8 == o - =3 General - %Conditional Formatting - iﬁ“lnsert - 2 %Y H
Pacte By - & I e $ - % GFormat as Table~ &7 Delete ~ m' Sort & Find &
- 4 B I U A EEEEE T L?Cell Styles = EI Format = 2 " Filter~ Select~
Clipboard Font ] Alignment ' MNumber Styles Cells Editing ~
Al - Jx | plotTitle: 10332636 MalloryBrook MB-1 Barkhamsted v
A B C D E 1[=

1 |Plot Title: 10332636 MalloryBrook MB-1 Barkhamsted |

2 |# Date Time, GMT-04:00 Temp, °C (LGR 5/N: 10332636, SEN 5/N: 10332636)

3 1 5/7/2014 16:00 9.608

4 2 5/7/2014 17:00 9.632

5 3 5/7/2014 18:00 9.608

6 4 5/7/2014 19:00 9.509

7 5 5/7/2014 20:00 9.336

a 6 5/7/2014 21:00 9.04

9 7 5/7/2014 22:00 8.717

10 8 5/7/2014 23:00 8.394

11 9 5/8/2014 0:00 8.095

12 10 5/8/2014 1:00 7.845
13 11 5/8/2014 2:00 7.67
14 12 5/8/2014 3:00 7.544
15 13 5/8/2014 4:00 7.393
16 14 5/8/2014 5:00 7.293
17 15 5/8/2014 6:00 7.192
13 16 5/8/2014 7:00 7.142
19 17 5/8/2014 8:00 7.192
20 18 5/8/2014 9:00 7.318
21 19 5/8/2014 10:00 7.469
22 20 5/8/2014 11:00 7.594
23 21 5/8/2014 12:00 7.72
24 22 5/8/2014 13:00 7.845
25 23 5/8/2014 14:00 7.945
26 24 5/8/2014 15:00 8.145
27 25 5/8/2014 16:00 8.295
28 26 5/8/2014 17:00 8.419
29 27 5/8/2014 18:00 8.543
30 28 5/8/2014 19:00 8.593
31 29 5/8/2014 20:00 2.618
32 30 5/8/2014 21:00 8.618 =

10332636_MalloryBrook_MB-1_Bark i'_-i-) F] 3

READY H M -———F——+ 100%

4. Insert a column between column A and column B. In the new cell B2 type “Logger Serial #”. In cell B3
type the serial number of the logger that recorded the data contained in the spreadsheet (located in the plot
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title in Cell A1, at the top of the Excel window in the file name, and in the retrieval section of the
Monitoring Site Log & Field Data Sheet.) See the example below:

H ©- @ qr-_.?. = 10332636_MalloryBrook_MB-1_Barkhamsted_040714 @1600-090314@1028 - Excel ? B - 0O
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Meghan Ruta ~
LT & i o= . iti ing v sert v -

D Calibri Jun A s =E=4 P %‘ General %Condltlonal Formatting %“In_eﬂ: z %Y H

b By~ $ - 9% » [ZFormatas Table- X Delete ~ [T~ Sort & Find &
aste B S - - E == EeE = - v ort n
- ¥ B I - & L E=s=s=4 S 8 G Cell Styles ~ [ Format ~ ¥ ~ Filter~ Select~

Clipboard = Font ] Alignment . Number ] Styles Cells Editing

w - f

A B C D E

1 |Plot Title: 10332636 MalloryBrook MB-1 Barkhamsted

2 |# Logger Serial # |Date Time, GMT-04:00 Temp, °C (LGR S/N: 10332636, SEN 5/N: 10332636)

3 1 10332636 5/7/2014 16:00 9.608

4 2| 5/7/2014 17:00 9.632

5 3 5/7/2014 18:00 9.608

6 4 5/7/2014 19:00 9.509

7 5 5/7/2014 20:00 9.336

8 Al s/F/ana 2100 9 N4

5. Separate the date and time information from column C into two new columns.

a. Insert two columns between column C and Column D. (Left-click where it says “D” then,
with column D highlighted, right-click; select “Insert” from the menu that appears. Repeat to
insert a second column.)

b. Highlight column C. From the top menu select “Data” and then click on “Text to Columns”.
A “Convert Text to Columns Wizard” pop-up window will open. Select “Fixed width” then
click “Next.”

Convert Text to Columns Wizard - Step 1 of 3

7 =

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Mext, or choose the data type that best describes your data.
Original data type

Choose the file type that best describes your data:
) Delimited - Characters such as commas or tabs separate each field.
@ Fixed width - Fields are aligned in columns with spaces between each field.

Preview of selected data:

|z pate Time, GMT-04:00
/772014 4:00:00 DM
laks7/2014 S-00:00 DM
/742014 &:00:00 PM i

(Caear ) [Comm )

c. The wizard will display a new screen (Step 2) with a data preview. Use the scroll bar
at the right to scroll down through the data; check to insure that the line is correctly
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H 9 B -

FILE HOME INSERT PAGE LAYOUT
@2 2

From

Access

c1

#

1
2
4
5
[
8

9

10
11
12
13
14
15
16
17
18
19

n

Cc3

#

1
2
1
5
6
8
9

10
11

positioned between the date and time columns. Move the line as needed to insuer the

data wil Ibe correctly split between the two new columns. Click “Next” when you are

done.

The wizard will display a new screen (Step 3) to allow you to format the data in the

new columns and select the destination for the data. Click on the box with the red
arrow to the far right of where it says “Destination”. (The wizard will temporarily
reduce in size to allow you to indicate wher ein the spreadsheet you want the new

data to go.) Highlight columns D and E (the blank columns you created) and click

Enter. Click “Finish.” Your spreadsheet should now look similar to this:

From From From Other Existing Refresh
Web  Text Sources~  Connections All-

Get External Data

- S

6. Add a new column between columns B (logger serial #) and column C (original date/time column). Type
“Year” in cell C2. Using the original date/time column information as a guide enter the year that
corresponds with each row of data. (You can enter the year of the first row and the copy and paste it

Connections

Plot Title: 10332636 MalloryBrook MB-1 Barkhamsted

1
2
3
a
5
6
7
8
9

10
11
12
13
14
15
16
17

19

FORMULAS

I:B« ||= [=] Connections ;l Y

El Sort

DATA

B

VIEW ACROBAT

Filter

Yo Advanced  coumns

Sort & Filter

C

5/7/2014 16:00
5/7/2014 17:00
5/7/2014 18:00
5/7/2014 19:00
5/7/2014 20:00
5/7/2014 21:00
5/7/2014 22:00
5/7/2014 23:00
5/8/2014 0:00
5/8/2014 1:00
5/8/2014 2:00
5/8/2014 3:00
5/8/2014 4:00
5/8/2014 5:00
5/8/2014 6:00
5/8/2014 7:00
5/8/2014 8:00

slelwnia a-nn

Ex [ B X B-

Textto Flash  Remove Data  Consolidate What-If
Fill  Duplicates Validation ~

D

Logger Serial # Date Time, GMT-04:00 Date Time
10332636

5/7/2014 0:00
5/7/2014 0:00
5/7/2014 0:00
5/7/2014 0:00
5/7/2014 0:00
5/7/2014 0:00
5/7/2014 0:00
5/7/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00
5/8/2014 0:00

slelania n-nn

Data Tools

E

» GMT-04:00

4:00:00 PM
5:00:00 PM
6:00:00 PM
7:00:00 PM
8:00:00 PM
9:00:00 PM
10:00:00 PM
11:00:00 PM
12:00:00 AM
1:00:00 AM
2:00:00 AM
3:00:00 AM
4:00:00 AM
5:00:00 AM
6:00:00 AM
7:00:00 AM
8:00:00 AM

Q.Annn AR

Analysis

Qutline

F

Meghan Ruta ~

5 -
! ==

Group Ungroup Subtotal

Temp, °C (LGR S/N: 10332636, SEN §/N: 10332636)

9.608
9.632
9.608
9.509
9.336

9.04
8.717
8.394
8.095
7.845

7.67
7.544
7.393
7.293
7.192
7.142
7.192

7310

down into subsequent rows.) If your data contains 12 month data, make sure to change the year when you
reach January 1 of the next year. Your data should look similar to the following:

- £

2014

Plot Title: 10332636 MalloryBrook MB-1 Barkhamsted

1
2
3
4
5
]
7
8
a

B

Logger Serial # Year

10332636

I}

Date Time, GMT-04:00 Date Time

2014
2014
2014
2014
2014
2014
2014
2014
nmia

D

5/7/2014 16:00
5/7/2014 17:00
5/7/2014 18:00
5/7/2014 19:00
5/7/2014 20:00
5/7/2014 21:00
5/7/2014 22:00
5/7/2014 23:00

s/a/7014 nnn

3

, GMT-04:00
5/7/2014 0:00 4:00:00 PM
5/7/2014 0:00 5:00:00 PM
5/7/2014 0:00 6:00:00 PM
5/7/2014 0:00 7:00:00 PM
5/7/2014 0:00 8:00:00 PM
5/7/2014 0:00 9:00:00 PM
5/7/2014 0:00 10:00:00 PM
5/7/2014 0:00 11:00:00 PM
s/a/2ma nnn 172:00000 AN

7. Delete the first column (the one that contains the “Plot Title”). Then delete the top row.

8. Change your column headers to read: “Logger Serial #”, “Year”, “Date Time”, “Date”, “Time”, and

“Temp C”.
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9. Click on the cell that contains the logger serial number to highlight it. Double-click on the green box that

10.

appears in the lower right corner to copy the serial number to the rows beneath it.

Add the title “Organization” to column G (cell G1) and beneath it type the name of the organization

responsible for the data. Add the title “Stream” to column H (cell H1) and beneath it type the name of the

stream monitored. Click on the cell that contains the organization name and stream name to highlight
them. Double-click on the green box that appears in the lower right corner to copy the information to the

rows beneath. Your data should look similar to the following:

L10 - fe
A B C D E F G H

1 |Logger Serial # Year Date Time Date Time Temp C Organization Stream

2 10332636 2014 5/7/201416:00 5/7/20140:00 4:00:00 PM  9.608 Mallory Brook Watershed Assaciation Mallory Brook
3 10332636 2014 5/7/201417:00 5/7/20140:00 5:00:00 PM  9.632 Mallory Brook Watershed Association Mallory Brook
4 10332636 2014 5/7/201418:00 5/7/20140:00 6:00:00 PM  9.608 Mallory Brook Watershed Assaciation Mallory Brook
5 10332636 2014 5/7/201419:00 5/7/20140:00 7:00:00 PM  9.509 Mallory Brook Watershed Assaciation Mallory Brook
3] 10332636 2014 5/7/201420:00 5/7/20140:00 8:00:00 PM  9.336 Mallory Brook Watershed Association Mallory Brook
7 10332636 2014 5/7/2014 21:00 5/7/2014 0:00 9:00:00 PM 9.04 Mallory Brook Watershed Association  Mallory Brook
21 10332636 2014 5/7/201422:00 5/7/2014 0:00 10:00:00 PM  8.717 Mallory Brook Watershed Assaciation Mallory Brook
2] 10332636 2014 5/7/201423:00 5/7/20140:00 11:00:00 PM  8.394 Mallory Brook Watershed Association Mallory Brook
10 10332636 2014  5/8/20140:00 5/8/2014 0:00 12:00:00 AM  8.095 Mallory Brook Watershed Assaociation Mallory Brook
11 10332636 2014  5/8/20141:00 5/8/2014 0:00 1:00:00 AM  7.845 Mallory Brook Watershed Assaociation Mallory Brook
12 10332636 2014  5/8/2014 2:00 5/8/2014 0:00 2:00:00 AM 7.67 Mallory Brook Watershed Association  Mallory Brook
13 10332636 2014  5/8/20143:00 5/8/2014 0:00 3:00:00 AM  7.544 Mallory Brook Watershed Assaciation  Mallory Brook
14 10332636 2014  5/8/20144:00 5/8/2014 0:00 4:00:00 AM  7.393 Mallory Brook Watershed Association Mallory Brook
15 10332636 2014  5/8/20145:00 5/8/20140:00 5:00:00 AM  7.293 Mallory Brook Watershed Assaociation  Mallory Brook
16 10332636 2014  5/8/20146:00 5/8/2014 0:00 6:00:00 AM  7.192 Mallory Brook Watershed Assaciation Mallory Brook
17 10332636 2014  5/8/2014 7:00 5/8/20140:00 7:00:00 AM  7.142 Mallory Brook Watershed Association Mallory Brook
18 10332636 2014  5/8/20148:00 5/8/2014 0:00 8:00:00 AM  7.192 Mallory Brook Watershed Association  Mallory Brook
19 10332636 2014  5/8/20149:00 5/8/2014 0:00 9:00:00 AM  7.318 Mallory Brook Watershed Assaociation Mallory Brook
20 10232636 2014 5/8/201410:00 5/8/2014 0:00 10:00:00 AM  7.469 Mallory Brook Watershed Association Mallory Brook
21 10332636 2014 5/8/201411:00 5/8/2014 0:00 11:00:00 AM  7.594 Mallory Brook Watershed Assaciation Mallory Brook
22 10332636 2014 5/8/2014 12:00 5/8/2014 0:00 12:00:00 PM 7.72 Mallory Brook Watershed Association  Mallory Brook
23 10332636 2014 5/8/201413:00 5/8/20140:00 1:00:00 PM  7.845 Mallory Brook Watershed Association  Mallory Brook
24 10332636 2014 5/8/201414:00 5/8/20140:00 2:00:00 PM  7.945 Mallory Brook Watershed Assaciation Mallory Brook
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Add the title “Site” to column I and beneath it type the site number assigned to that monitoring location
by the volunteer group coordinator. (This should be recorded at the top of the Monitoring Site Log &
Field Data Sheet and included in the file name at the top of your Excel window.) Left-click on the cell,
then right-click and select “copy.” Click on cell I-3, and while holding down the left mouse button, scroll
down to highlight, for all remaining rows with data, the cells in column I. When done right-click and
select paste. All rows of data should now have the same site number assigned to them.

Highlight column D (“Date”) and then from the menu at the top of the window select Home > Format >
Format Cells. Click on the “Number” tab and select “Date” from the Category list. Select the top option
from the type list to select date in the *M/DD/YYY'Y format and click “OK.”

Highlight column E (“Time”) and then from the menu at the top of the window select Home > Format >
Format Cells. Click on the “Number” tab and select “Time” from the Category list. Select the second
option from the type list to select time in the HH:MM military format and click “OK.”

Highlight column F (“Temp C”) and then from the menu at the top of the window select Home > Format
> Format Cells. Click on the “Number” tab and select “Number” from the Category list. In the decimal
places field type “3” and click “OK”.
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15. Your data should look similar to the following:

A

B

C

Logger Serial # Year Date Time

1

2 10332636
3 10332636
4 10332636
5 10332636
6 10332636
7 10332636
8 10332636
9 10332636
10 10332636
11 10332636
12 10332636
13 10332636
14 10332636
15 10332636
156 10332636
17 10332636
18 10332636
19 10332636
20 10332636
21 ANIITVRIR

2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014
2014

an1A

5/7/2014 16:00
5/7/2014 17:00
5/7/2014 18:00
5/7/2014 19:00
5/7/2014 20:00
5/7/2014 21:00
5/7/2014 22:00
5/7/2014 23:00
5/8/2014 0:00
5/8/2014 1:00
5/8/2014 2:00
5/8/2014 3:00
5/8/2014 4:00
5/8/2014 5:00
5/8/2014 6:00
5/8/2014 7:00
5/8/2014 8:00
5/8/2014 9:00
5/8/2014 10:00

ciofania 11-nn

16. Save and close your file.

Date

D E

5/7/2014 16:00
5/7/2014 17:00
5/7/2014 18:00
5/7/2014 19:00
5/7/2014 20:00
5/7/2014 21:00
5/7/2014 22:00
5/7/2014 23:00
5/8/2014 0:00
5/8/2014 1:00
5/8/2014 2:00
5/8/2014 300
5/8/2014 400
5/8/2014 5:00
5/8/2014 6:00
5/8/2014 700
5/8/2014 8:00
5/8/2014 9:00
5/8/2014 10:00

ciofania 19-nn

F G

Time Temp C Organization

9.608 Mallory Brook Watershed Association
9.632 Mallory Brook Watershed Association
9.608 Mallory Brook Watershed Association
9.509 Mallory Brook Watershed Association
9.336 Mallory Brook Watershed Association
9.040 Mallory Brook Watershed Association
8.717 Mallory Brook Watershed Association
8.394 Mallory Brook Watershed Association
3.095 Mallory Brook Watershed Association
7.845 Mallory Brook Watershed Association
7.670 Mallory Brook Watershed Association
7.544 Mallory Brook Watershed Association
7.393 Mallory Brook Watershed Association
7.293 Mallory Brook Watershed Association
7.192 Mallory Brook Watershed Association
7.142 Mallory Brook Watershed Association
7.152 Mallory Brook Watershed Association
7.318 Mallory Brook Watershed Association
7.469 Mallory Brook Watershed Association

T 20A RAallams Dranlk VAlatarchad Accmrciation

Repeat the above process for any remaining loggers that need to be downloaded.

CT DEEP WPLR Volunteer Stream Temperature Monitoring Network Manual

H
Stream
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook
Mallory Brook

BAsllAmr Dranl

Last Revised 04/25/17

Site

MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
MB-1
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DATA SUBMISSION TO DEEP

For CT DEEP WPLR to use volunteer data in our projects, the following files must be submitted to

DEEP:

e For each logger/site monitored:
Scanned copy of the completed Monitoring Site Log & Field Data Sheet
Site photographs — labelled with photograph date, stream name, and site number

O

O

O

O

e The program QC log summarizing individual QC results

Original logger data download (.hobo file)
Cleaned logger data (Excel file)

e Logger QC files (.hobo and .Excel files)

Due to the size and volume of files that must be submitted, do not email files to DEEP. It is recommended that
coordinators organize their files onto a USB stick or CD for submission. Please organize files so that all files for
a particular site (i.e. scanned data sheet, photographs and logger data) are contained in individual folders labelled
with the site number. QC files and scanned logs can be organized in a separate “QC File” folder. See below as an

example.
[o ) o=
l\;uju\ujl | + Stream Temperature Monitoring Program » - | 4 | | Search Stream Temperature Monitonn... S [
Organize « Mew folder i+ 0 @
i MName ’ Date modified ¥  Type Si

4 5.7 Favorites

m

Bl Desktop MalloryBrook_MB-1
4 Downloads MalloryBrook_MB-2
=il Recent Places QC Files

‘WalnutBrook_WB-1
= Libraries

4 1M Computer

m

o A
5 f

0/201512:52 PM File folder
0/2015 12:52 PM File folder
09/201512:52 PM File folder
0/2015 12:52 PM File folder

Mail or hand

-deliver files to:

Meghan Lally

CT DEEP Bureau of Water Protection & Land Reuse

Planning & Standards Division
Monitoring & Assessment Program
79 Elm Street

Hartford, CT 06106-5127
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APPENDIX A:
QC CHECK LOG
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APPENDIX B:
MONITORING SITE LOG & FIELD DATA SHEET
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APPENDIX C:
SITEPHOTOGRAPH INSTRUCTIONS
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APPENDIX D:
USING EXCEL TO CALCULATE CT SUMMER
METRICS
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